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Import of loudspeaker magnitude and phase data into an Ease 4.0 
Speaker Model file 

EASE 4.0 allows a variety of ways to enter measured data from loudspeakers into files that are then 
used to model the results. The module used for this capability is called the EASE Speaker Base. 

 

Figure 1: EASE 4.0 Speaker Base Opening Screen 

This module accepts the data in the following formats: 

1) Using manual entry, magnitude data can be directly entered using 'Attenuation Data' from the 
'Edit' menu.  Phase data can be directly entered using 'Phase Data' from the 'Edit' menu.  This 
allows data in 1/3 Octave 5° increments.  (See Manual Entry on page 7.) 
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2) Use 'Import ASCII' from the 'File' menu. The latest version of TEF polar exports its data in this 
format. After the import is finished, EASE will ask whether or not to check the 'Use Phase Data' 
checkbox in the 'Speaker Model' dialog. This allows data in 1/3 Octave 5° increments. We will 
soon provide an Excel template that allows the generation of such ASCII files easily.  (See Import 
ASCII on page 9.)  

3) Use 'Import Impulse Response' from the 'File' menu. This will allow you to enter data stored as 
Impulse Responses in time-domain files. EASE will extract complex data (magnitude and phase) 
automatically and when it is finished, will ask whether or not to check the 'Use Phase Data' 
checkbox in the 'Speaker Model' dialog.  (See Import Impulse Response on page 11.)  The file 
formats supported by EASE 4.0 are: 

a. The .TIM format used by the program MLSSA from DRA Laboratories 
(www.mlssa.com). This format allows data measured at 5° increments for a quarter, half 
or full sphere. EASE currently will create a data set with 1/3 octave resolution. 

and 

b. Impulse Responses stored as standard .WAV files. This format allows data measured at 5° 
increments for a quarter, half or full sphere. EASE currently will create a data set with 1/3 
octave resolution. 

4) Incorporating high-resolution data sets into a Loudspeaker DLL accommodates the highest 
resolution capability. This currently is used for Speaker Models measured in high resolution or 
complex line arrays, and can also be used for the complex interaction of multi-driver 
loudspeakers. The description of the DLL format is outside the scope of this document.  (See 
High Resolution using a Loudspeaker DLL on page 14.) 

Case Symmetry and Database Authorization in EASE 

EASE 4.0 now allows the use of asymmetrical cases with loudspeakers that have symmetrical data.  If 
the loudspeaker is used in a model that has Symmetry turned on, then only the symbol will be shown, 
not the actual case.  

Note 

EASE 3.0 did not normally allow the use of an asymmetrical case with symmetrical data.  You 
could insert a loudspeaker with an asymmetrical case, but it would show a mirror image of the 
case, even in symmetrical rooms. 

EASE 4.0 also allows the user to change the case without changing the loudspeaker checked status or 
authorization.  This allows users to add cases to loudspeakers that do not have them, as well as to 
create simpler or more complex cases for presentation purposes. 
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Device Orientation for Measurement and Modeling in EASE 

The Device Coordinate System (DCS) for EASE Speaker Models is based on the Room Coordinate 
System (RCS) used in EASE for the model. The measurement of a Speaker Model uses a Rotation 
Point (RP) that is a common reference for all of the acoustical measurements.  This RP will be used as 
the Point Of Reference (POR) when the loudspeaker is inserted into an EASE model. 

The location of the POR is by default at 0, 0, 0 in the Speaker Model, and is located at the intersection 
of the axes in the Edit Case window.  In reality the Case for the loudspeaker may have a different 
reference point than the default POR (normally the center of gravity of the box).  Then this 3D 
physical offset (this information has to be supplied by the manufacturer) to the default POR is stored 
with the Speaker Model data as shown in Figure 2. This is now the new POR used for inserting the 
speaker model into the EASE project. If phase data is to be included, the checkbox ‘Use Phase Data’ 
should be selected in the Speaker Model dialog box as shown in Figure 2.   

 
Figure 2: Speaker Model dialog box 

 

Figure 3: Move Point of Reference  

To adjust the location of the case relative to 
the actual Point Of Reference, select ‘Move 
Point of Reference’ from the Tools menu in 
the Edit Case module. Enter the amount to 
move the case origin into the dialog box 
shown in Figure 3 and select OK.  

If the case has been imported using ‘Load 
DXF Case Data’ from the File menu in the 
Edit Case window, and the DXF 0,0,0 point 
has been set to the RP of the Speaker Model, 
then the Case will not need to be moved. 

Figure 2 shows that for this loudspeaker, the POR is located on the horizontal centerline, 0.10m in the 
direction of negative Y, and 0.44m above the case origin.   

Here are views of a loudspeaker where the RP has been chosen by the manufacturer to be the 17 ½ 
inches above, and 4 inches forward, of the bottom middle of the back of the loudspeaker cabinet. This 
is the same device that was shown in Figure 2.  This Rotation Point is used by EASE as the POR for 
all acoustical calculations.   
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Figure 4: Plan and 3D Loudspeaker views showing the Rotation Point for the measurements 

  

Figure 5: Front and Side Loudspeaker views showing the Rotation Point for the measurements 
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Axis and Rotation Directions in an EASE model 

The rotation direction for both the measurement of Speaker Models and their subsequent use in an 
EASE model is defined using the right-hand rule. 

The right-hand rule determines the positive axis direction of the Z axis when you 
know the direction of the X and Y axes in a 3D coordinate system. The right-hand 
rule also determines the positive rotation direction about an axis in 3D space.  

To determine the positive axis direction of the X, Y, and Z axes, place the back of 
your right hand near the screen. Point your thumb in the direction of the positive X axis. Extend your 
index and middle fingers as illustrated and point your index finger in the direction of the positive Y 
axis. Your middle finger indicates the direction of the positive Z axis.  

To determine the positive rotation direction about an axis, point your right thumb in the 
positive direction of the axis and curl your fingers as illustrated. Your fingers indicate 
the positive rotation direction about the axis.  

Here is a view of a single horn and driver loudspeaker showing the positive rotation direction for each 
of the Loudspeaker aiming axes. Direction for the positive Horizontal angle is shown in Blue.  
Direction for the positive Vertical angle is shown in Red.  Direction for the positive Rotation angle is 
shown in Green.   

 

Figure 6: Rotation Directions for aiming a Loudspeaker in EASE using the Device Coordinate System 

Note 

These Loudspeaker X and Y directions are the opposite of the directions used in EASE for the axis 
directions of X and Y in the model. It is not recommended to have a loudspeaker aiming direction 
that is different from the Speaker Model orientation. If it is different, it should be specified and 
shown in a drawing. 



Loudspeaker Device File Formats for EASE 4.0  Page 6 of 14 
Version 4.04e 

Axis and Rotation Directions for Loudspeaker Measurements 

These same rotation directions are used for the collection of data in the measurement process.  Using 
Figure 6, the angles for Phi are from 0 to 355 around the Y axis (Green). An angle of 0° is the Speaker 
Model negative X axis (towards the right in Figure 6), 90° is the Speaker Model positive Z axis, 180° 
is the Speaker Model positive X axis, and 270° is the Speaker Model negative Z axis. 

The angles for Theta are from 0° to 180°. An angle of 0° is always the Speaker Model aiming 
direction (the direction the Speaker Model is normally aimed), 90° is perpendicular to the Speaker 
Model aiming direction, and 180° is opposite the Speaker Model aiming direction. 

 

 
Figure 7: PHI angle of 0° 

Figure 7 shows the direction to measure the 
Theta angles from 0° to 180° for a Phi angle 
of 0°. This data will be entered into the 0° 
column in Manual Entry below. 

 

 
Figure 8: PHI angle of 90° 

Figure 8 shows the direction to measure the 
Theta angles from 0° to 180° for a Phi angle 
of 90°. This data will be entered into the 90° 
column in Manual Entry below. 

 

 
Figure 9: PHI angle of 180° 

Figure 9 shows the direction to measure the 
Theta angles from 0° to 180° for a Phi angle 
of 180°. This data will be entered into the 
180° column in Manual Entry below. 

 
Figure 10: PHI angle of 270° 

Figure 10 shows the direction to measure the 
Theta angles from 0° to 180° for a Phi angle 
of 270°. This data will be entered into the 
270° column in Manual Entry below. 
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Manual Entry 

The hardest way to enter the data is by typing it directly into the speaker database. This is really only 
useful for entering information from ‘Legacy’ Speaker Models that need to be modeled.  

Magnitude Data 

Data for each of the measured Theta magnitude values should be entered into the Attenuation Data 
dialog box shown in Figure 11. Each column corresponds to a single Phi angle. Enter the data into the 
row corresponding to the Theta angle for that measurement.  A negative value represents attenuation 
in dB relative to the on-axis value, and a positive value indicates the gain in dB relative to the on-axis 
value.   

 

Figure 11: Entry of Magnitude Data 

If only the horizontal and vertical polar values are available, EASE will use an Elliptical Lobe 
algorithm to calculate the remaining values. Select Compute Elliptic Lobe from the Attenuation Data 
menu. The number of columns that need to have the data filled in depends on whether the Symmetric 
checkbox has been checked. (See Figure 2) See Figures 4 to 7 to select the correct measurement 
direction. 

Symmetric is checked: 

• Symmetry is on, fill the 0°, 90°, and 270° columns. 

The algorithm will compute these two quarters based on the polars and afterwards will mirror the 
data horizontally. If the Speaker Model is also vertically symmetrical, just enter the same data in 
the 270° column that was entered in the 0° column. 

Symmetric is not checked: 

• Symmetry is off, fill the 0°, 90°, 180°, and 270° columns. 

The algorithm will compute all four quarters based on the polars.  The Lobe does not need to be 
symmetrical! 
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Phase Data 

Data for each of the measured Theta phase values should be entered into the Phase Data dialog box 
shown in Figure 12. Each column corresponds to a single Phi angle. Enter the data into the row 
corresponding to the Theta angle for that measurement.  Positive and negative values represent the 
phase in degrees.  Any editing here will cause a message to display asking if the "Use Phase Data" 
checkbox should be checked. (See Figure 2) 

If only the horizontal and vertical polar values are available, EASE will use an Elliptical Lobe 
algorithm to calculate the remaining values. Select Compute Elliptic Lobe from the Phase Data menu.  
The number of columns that need to have the data filled in depends on whether the Symmetric 
checkbox has been checked. (See Figure 2) See Figures 4 to 7 to select the correct measurement 
direction. 

Symmetric is checked: 

• Symmetry is on, fill the 0°, 90°, and 270° columns. 

The algorithm will compute these two quarters based on the polars and afterwards will mirror the 
data horizontally. If the Speaker Model is also vertically symmetrical, just enter the same data in 
the 270° column that was entered in the 0° column. 

Symmetric is not checked: 

• Symmetry is off, fill the 0°, 90°, 180°, and 270° columns. 

The algorithm will compute all four quarters based on the polars.  The Lobe does not need to be 
symmetrical! 

As an alternative the phase data can be computed using a Minimum Phase algorithm based on the 
Hilbert Transform. Select Compute Minimum Phase from the Phase Data menu.  This algorithm 
computes the phase balloon based on the attenuation data and the assumption of a "well-behaved" 
system.  

 

Figure 12: Entry of Phase Data 
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Import ASCII 

An ASCII file that has been created by a measurement system, an EXCEL spreadsheet, or another 
program can be used to enter either magnitude only, or magnitude and phase data for a single 
loudspeaker. This file must conform to the DOS/Windows standard for text files.  Each line must be 
terminated with a carriage return and line feed pair of characters. 

ASCII File Format 

Each ASCII Speaker Model file has a header section that typically has a few lines of comments 
followed by three (3) header variables. Each line that begins with a semi-colon is treated as a 
comment. 

Here is an example of a typical comment section:  
;  EASE 4.0  © ADA 
; 
;  Exported on 2/28/2002 1:26:59 PM  
; 
; ================================== 
; 

Each of the header variable lines consists of the variable name followed by the value in a comma-
separated-value format.  

The first line following the comments should be the following: 
"FileType","Speaker Types" 

This should be followed by the format of the file.  
"Format",4.0 

Finally, the units used should be specified. Valid units are "ft" and "meters". 
"LengthUnit","ft" 

Following the header section will be a frequency header section for each of the frequencies that are to 
be included in the Speaker Model file. Here is an example: 
"SpeakerName","Measured Array" 
"Manufacturer","Loudspeakers, Inc." 
"Frequency",100,"Hz" 
"Sensitivity",96,"dB" 
"Impedance",4,"ohms" 
"Q",1.6 
"Efficiency",3.1,"%" 
"MaxPower",1200,"W" 
"DataGood",1 

Following the frequency header section will be a row for each of the 72 PHI angles consisting of 37 
THETA values. Each of these rows will start with the PHI angle label followed by comma-separated 
values. A positive value represents attenuation in dB relative to the on-axis value, and a negative value 
indicates the gain in dB relative to the on-axis value.  Here is an example of the first label: 
"  0°", 0.00, 0.10, 0.50, … 
"  5°", 0.00, 0.50, 1.10, … 
. 
. 
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. 
"355°", 0.00, 0.50, 1.10, … 

 

Next are three (3) lines for the isobars represent the –3dB, -6dB, and –9dB contours.  Each of these 
rows will start with the contour label followed by 72 comma-separated values for the PHI angle in 
degrees. Here is an example of the first label: 
" 3dB", 86, 87, 85, 84, 86, … 
" 6dB", 120, 122, 118, 119, 122, … 
" 9dB", 180, 180, 180, 180, 180, … 

If phase data is included, the next line will be the following label: 
"PhaseData" 

This will be immediately followed by a row for each of the 72 PHI angles consisting of 37 THETA 
values. Each of these rows will start with the PHI angle label followed by comma-separated values. 
The values are the Phase angle in degrees for each THETA point.  This section will then be followed 
by the "End" label Here is an example of the first label: 
"  0°",  -2.0,  -0.5,  -1.9,  … 
"  5°",  -0.2,  -0.9,  -0.7,  … 
. 
. 
. 
"355°",  -0.2,   0.0,  -1.3,  … 
"End" 

Case data can also be included in the file, if desired. If the case data is included, the next line will be 
the following label followed by the name of the speaker: 
"SpeakerFace","Measured Array" 

A block of data like the following will represent each of the faces in the case: 
"Material","ABSORBER" 
2.001312,1.771654,.656168 
2.001312,0,.82021 
2.001312,0,-.82021 
2.001312,1.771654,-.656168 
"End" 

An additional “End” label will follow the end of this section. 
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Import Impulse Response (WAV and TIM) 

This new option allows you to directly import measured impulse responses in time-domain files in a 
WAV format. It will also allow import of MLSSA TIM time-domain files. This procedure 
automatically generates complex speaker data in the native resolution of EASE.  

A file can be specified for a single direction angle as shown in the following dialog box: 

 

Figure 13: Import of a single MLSSA TIM file 

A file-naming mechanism has been created in order to minimize cross-platform issues with Operating 
Systems by limiting them to an 8.3 format. All IR wave files will be stored in the form 
'IRpppttt.ext'.  

ext is the placeholder for the file extension. WAV and TIM are the valid extensions that should 
be used for standard wave files or MLSSA files, respectively. 

ppp represents the 3 digit value from 0 to 355 for the angle of PHI  (meridians). The horizontal 
polar consists of the values at 0° and, optionally, 180°. The vertical polar consists of the values 
at angle 90° and, optionally, 270°. When looking INTO the mouth of a horn (it is pointed at 
you), 0 degrees is to the right and increases in a counter-clockwise direction. (90° is to the top 
looking into the mouth of a horn.) 

ttt represents the 3 digit value from 0 to 180 for the angle of THETA (parallels). 0 degrees is 
the on-axis aiming point.  

All angle values are padded with zeroes to three places so that all file names are of a uniform length.  
In the future, this will also allow an angular resolution as fine as 1°. 
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Here is an example of the import of a full sphere data set: 

 

Figure 14: Complete Data Set Impulse Response Import 

The Theta resolution is always 5°, consisting of 37 values from each meridian 0°-180°.  The Data and 
Symmetry selections in Figure 14 refer to the number of Phi angles that are in the set.  There are six 
possible file set sizes, three for polar only data and three for 5-degree data sets. From the smallest set 
to the largest they are defined as follows: 

Polars Only - Full Symmetry (a Quarter Sphere of data) 72 files 
  IR000000.ext (1 file) 
  IR000005.ext - IR000175.ext (35 files) 
  IR090005.ext - IR090175.ext (35 files) 
  IR000180.ext  (1 file) 

Polars Only - Half Symmetry (a Half Sphere of data) 107 files 
  IR000000.ext (1 file) 
  IR000005.ext - IR000175.ext (35 files) 
  IR090005.ext - IR090175.ext (35 files) 
  IR270005.ext - IR270175.ext (35 files) 
  IR000180.ext  (1 file) 

Polars Only - No Symmetry (a Full Sphere of data) 142 files 
  IR000000.ext (1 file) 
  IR000005.ext - IR000175.ext (35 files) 
  IR090005.ext - IR090175.ext (35 files) 
  IR180005.ext - IR180175.ext (35 files) 
  IR270005.ext - IR270175.ext (35 files) 
  IR000180.ext  (1 file) 

5° Steps - Full Symmetry (a Quarter Sphere of data) 667 files 
  IR000000.ext (1 file) 
  IR000005.ext - IR085175.ext (630 files) 
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  IR090005.ext - IR090175.ext (35 files) 
  IR000180.ext  (1 file) 

5° Steps - Half Symmetry (a Half Sphere of data) 1297 files 
  IR000000.ext (1 file) 
  IR000005.ext - IR085175.ext (630 files) 
  IR090005.ext - IR090175.ext (35 files) 
  IR270005.ext - IR355175.ext (630 files) 
  IR000180.ext  (1 file) 

5° Steps - No Symmetry (a Full Sphere of data) 2522 files 
  IR000000.ext (1 file) 
  IR000005.ext - IR085175.ext (630 files) 
  IR090005.ext - IR175175.ext (630 files) 
  IR180005.ext - IR265175.ext (630 files) 
  IR270005.ext - IR355175.ext (630 files) 
  IR000180.ext  (1 file) 

Note 

There is only one file each required for the Theta angles of 0° and 180°. 
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High Resolution using a Loudspeaker DLL 

A loudspeaker manufacturer has the option of using the EASE DLL Interface Kit to include data for 
loudspeakers that have higher resolution requirements than 1/3 Octave at 5° angles. This also allows 
the use of complex filters for steering of arrays, and can include the controls normally found in the 
control software for the array as part of the setup for the loudspeaker in EASE. 

In addition, the behavior of sources modeled by a DLL is not restricted by a far field assumption. 
There is no need to use a balloon. Data may be measured and implemented as a 4D-matrix 
(X, Y, Z, dB). The behavior can also be implemented as a functional relationship or as a hybrid 
approach using mathematical expressions with measured corrections. (Line Arrays) 

It is also possible to include a manufacturer-specific user interface, which can be called from within 
EASE. 

 

 


